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Network Processor Routers (NPRs)

[100+ endhosts]

3 - Ken Wong— 10/14/2009 & Washington University in St.Louis

Why Build ONL?

m Hands-on experience with real hardware
»Make education more concrete = reinforce concepts

» Achieve through virtualization
+ Need to protect user from actions of other users
«Need to mimic propagation delay and link capacity

m Support experiment/observation approach
» Extensive monitoring facility

» Observe effects of config. changes on network traffic
«=>» insights and greater understanding through observations

» Easy-to-use Remote Laboratory Interface (RLI)
m Access to advanced router features
» Gbps links, filters, packet scheduling
»Plugins: Program insertion along packet data path

4 - Ken Wong— 10/14/2009 & Washington University in St.Louis



Get An Account

) Open Network Laboratary [ONL] - Mozilla Firefox
e (& Yew Hgtory Qockmarks ook Wb

a = C wr (L) [ hemort s wnstl sduf -0 J
s e vered @ P e 1) Pt samont B Phapin £ ] Coen otk b2 onl.arl.wustl.edu,
OpenNetLab °
2259 | Open Network Laboratory]  onl-wustl.edu,
Information: www.onl.wustl.edu
SMLVIDEG | 4 Resonrce for Netwerking Researchers and Educators
ONL in Courses

Take a look at this ONL video - Real-Time Digplays, Router Pluging and Much Much More !
{ Your browser mwst have a media plaver pluzin The file 1= J0ME. )

A e
tutorial POCun SHES We are now accepling new users.
£ Click on the et an accownt link in the sidebar and follow the instructions.

FPhoto Gallery
- The Cpen Netwaork Laboratory 1= a vesonrce for the networkmg research and educational
Shet it aocoun: c t { 1 to enable experimental evalvation of achvanced networking concepts in a

; ti¢ working environment. The Natron nee Foundation hag supported ONL throngh
ONL Users: sty 526 and CNE 05551651 The laboratory 1z built seomnd open-sowrce, extensible,
acces

LED a

high § en developed at Washington University, and which can be
Username: g et an account ate Laboratory Interface (RLT). The RLT allows users to

confizure the testbed network. rn applica
Paseword: bnlt=in data gathering mechanisms that the rou
modity or replace the software ruming in the ¢
dynamically reconfizured to support new cay °

; . Group: onluser
to smlarly extend. modify or replace the roj :
vignalization and real-tume remote displays, [ @ 24 - h our co nfl rm atl on

wnderstand the behavior of new capabilities o1 password for Web & hOStS

monifor those nuning applications vsing the
The RLI also allows users to extend.
. e 4 o

gi*
H

5 - Ken Wong— 10/14/2009 & Washington University in St.Louis

Properties of ONL Accounts

m Same password for Web login and host login

m Host account restrictions

»Can only SSH to onl.arl.wustl.edu from remote host
¢ Actually end up on onlusr, the ONL user host
» Firewall blocks all connections from within ONL
o Can't push from ONL host to remote host
o Can’t pull to ONL host from remote host
«But can push to ONL host from remote host (e.g., scp)
«But can pull from ONL host from remote host
+«No email
» Can only access onlusr host and hosts assigned to
your experiment

m Password-free SSH between ONL hosts
» See “NPR Tutorial®Summary Information=»Password-Free SSH”

6 - Ken Wong— 10/14/2009 & Washington University in St.Louis



Getting Started

m See sidebar at www.onl.wustl.edu
m Follow instructions in “Getting Started” link
= Read NPR Tutorial
» Packet Processing
» The Remote Laboratory Interface
» Filters, Queues and Bandwidth
m Other useful tutorial sections
» Examples = The Remote Laboratory Interface
» Examples =» Filters, Queues and Bandwidth

7 - Ken Wong— 10/14/2009 & Washington University in St.Louis

SSH Tunnel Configuration

m Build before each experimental session
» Allows your RLI to communicate with ONL daemon
» Needed to make reservation or run experiment

m Cookbook for 3 approaches
»Unix or Unix-like (e.g., cygwin)
essh -L 7070:onlsrv:7070 onl.arl.wustl.edu
oI use this (defined as an alias) from Linux

»MS Windows PuTTY (GUI-based)
oI use this from my Microsoft XP laptop
» And also the SSH agent pageant (optional)
o See Tutorial for URL (free software)

» Microsoft Windows SSH client tool from SSH Corp
m Follow instructions on ONL web pages

»Don’t agonize over it = See TA after 2-3 tries

» If problems, send email to your grader/consultant

8 - Ken Wong— 10/14/2009 & Washington University in St.Louis



PUuTTY SSH Tunnel Configuration

S PuTTY, Configuration 3] [ external host name =
Categaony:
= Session Basic options for your PUTTY session onl.arl.wustl.edu
Logaing Specify your connection by host name of [P addres:
=) Temminal
Host Name [or P addiess] o
Keyboard
Ball anl.arl st edu 22
Festuiss | Protosal PuTTY Canfiguration X
(= Window O Raw O Teinet (O Rlogin - G)55H Category
:ZE:EE'EE Load, save or delete 5 stored session (=) Session Options controling 5SH tunneling
Trarslation | | Saved Sessions i 1oogging %11 forwarding
Selection il Keghoard [JEnabls %11 forwarding
. Eolours Defaull Settings Bel X display localion
=) Cornection arlwistl edu
Features Remote %11 authentication protocol
P on| .
T = Window @ MIT-MagicCookis1 0 ¥DMAuthorization-
. Appearance
e Aopcamcs | i
= SSHA h Translation [ Local ports accept connections from other hasts
T:nnels Selection ] Remote parts do the same [SSH +2 only)
Cif \vindow on exit Colours e pats
Bugs ys  OMNever @ Only on clean esi - Connention [ Remave |
Proxy L7070 onkne: 7070
Telnet
B 55H Add new fan
“uth Saurce part Add
Turnels
Bugs Destinat
e local port 7070
session name = rli remote host onlsrv
oLt
remote port 7070 }
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Under the SSH Tunnel Hood

NPR
your host controls

(localhost)

RLI | ONL
§ daemon
'l port 7070

virtualization

Experiment

onlsrv

port 7070 ::
i port 22
ssh < . > sshd | onlusr

Firewall
onl.arl.wustl.edu
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Configuring a Virtual IP Network

= Topology m Queue Tables
» NPRs, hosts, links » per port
» Used for resource reservation » port rate
= Route Tables » datagram queues
« QIDs 0-63
” pe_r_port » reserved queues
» Initially empty at all ports « QIDs 64-8,191
» default RT: 1 port or all ports » queue parameters
» IP pkt forwarding « threshhold: queue size
« get pkt 1 hop closer to destination e guantum: scheduling weight
>>_ uses Longest Prefix Match - Plugin Tables
m Filter Tables » per NPR
» per port » standard plugins
» forward to port/queue . e.g., delay

» forward to plugin, port/queue » user-defined plugins

- Ken Wong— 10/14/2009 & Washinzton University in St.Louis

The NPR Data Path
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The Network Processor Router (NPR)

Microengine (ME)

[Local Memory||GPRs|

8 thread —4
~~
contexts Each NPR is
T ~1 one IXP 2800
with 16 MEs

: SP=p e
5 Ports | %:'

_________________ R G BHTp—

PCI,GigE [ SRAM || DRAM |

13 - Ken Wong— 10/14/2009 & Washington University in St.Louis

Route Table

Xscale Filters
ey R oy
2 1; 3 D1 2
port 0 M Parse i port 0
e ' | Queue Hdr e
In u Lookup = Manager [P|Fmt[] x s Out
port 4 X & Copy L port 4
! —
. 5 1 h
~---| Plugins --'
==
Implements for each output port:
— Port Rate and Bandwidth Sharing
Fast Path: normal 5 x 8,128 Reserved Queues (64-8191)
pkt path 5 x 64 Datagram Queues (0-63)
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NPR Packet Processing (2)

exception processing
(IP options, ARP, 0 TTL)

Xscale Queues for each port
drop pkt | CP  |=-- 1 Pkt Scheduler (5 ports)
= |
3 p 1 1 2
Parse ' port O
! ueue .
Lookup i— MQanager ¢ Out
% Copy h port 4
Coo=
S 4 K
Plugins |-~ "Ethernet encap
L

Classify pkt
Copy pkt

transmit
custom processing ethernet frame

8 threads/ME
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NPR Packet Processing (3)

m Rx: Receive Pkt
» Put pkt in DRAM; Send meta-packet
m Mux: Multiplex traffic (inputs, CP, plugins)
m PLC: Parse, Lookup and Copy
» Implements Route Table and Filter Table lookup
»Uses TCAM (Ternary Content-Addressable Memory)
® QM: Queue Manager

» Pkt scheduler for each of 5 output ports
« Implements port rate concept using token bucket

« Implements bandwidth sharing concept using Weighted
Deficit Round Robin (WDRR) algorithm

m Hdr Format
» Create ethernet frame

m Tx: Transmit Ethernet Frame
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Experiment 1

17 - Ken Wong— 10/14/2009 & Washington University in St.Louis

Topics
m 2 NPRs, 4 hosts, 2 links between NPRs

m Experiment files
»473-1-f09.exp
»473-1-filters-f09.exp (filters at ports 1.0 and 1.4)

m Unix commands

» /sbin/ifconfig network interface properties
» /bin/netstat network interface statistics
» /bin/ping ICMP echo/reply

» fusr/local/bin/iperf UDP/TCP traffic generator

m Route tables and port rate (capacity)

18 - Ken Wong— 10/14/2009 B Washington University in St.Louis




Experiment 1 (Final Version)

=10 NPR 2, port 1 receives
File Edit Monitoring Topology Extras Trafﬁc at ALMOST 12 Mbps
=10l x|
1.0
=14
B
‘ 23
! e T £
NPR'l NPR.2 WZi BF4.8 8873 6998
(337.648, 11,462 ) timeysecs)
Mb;lag 12b ébps T — [T
0—PPR----- p| 0D R——— »—> 1
¥l
asbg 12—l "2 nip0 starts | | n1p4 starts
10
Mbps Gbps
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Steps in Running an Experiment

m Define maximal network resources using RLI
» Required: Add NPR routers, Hosts, Links

Save configuration

» File =» Save as

Build SSH tunnel to onl.wustl.edu

Make a reservation

» File = Make reservation

» Can be an advanced reservation

m When reservation time arrives:

» Build SSH tunnel to onl.wustl.edu

» Run RLI and open configuration file

» Ask for network to be built: File =& Commit

» Define more network parameters (Commit) and monitoring
» Wait for commit to finish

Log into onl.wustl.edu using ssh

» Prompt will show you have logged into onlusr

» You can only access your ONL nodes from onlusr host
» Use Linux commands to run traffic generators

- Ken Wong— 10/14/2009 & Washington University in St.Louis



RLI Menus

m Menu File = ...

»Open, Commit (binds virtual network to actual
network components)

= Port = Route Table = Edit
» Add/Delete Route, Generate Local Default Routes
= Port = Queue Table

» Port Rate, Edit = Add/Delete Queue, Threshold,
Quantum

m Port = Filter Table = Edit
» Add/Edit/Delete Filter
m Menu Monitoring = Add Monitoring Display
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Send ping pkts from n1p0 to n2p1l

B Remote Laboratory Interfs N =3} A Remote Laboratory Interfa -Of x|
File Edit Monitoring Topology Extras File Edit Monitoring Topology Extras
B bandwidth o ] 3
Options  Parameter View
1n1p0 i
0G0 Oy |~ 0.001
182, 168.1.16
oy N 10
£ oowr il
User Data [ g mid

— =
ntpd —_ n :
ping traffic| i 0,000 ez

amif r\plei Shove Error Lag amif np\ei:

r
786 286 Az 6 108 6 126
time(secs)
o+ onl100.arlwustledu - PuTTY o T 1] D
onlusr> ssh onl0E0
SET IOMIRT WER AUE 5 13:54:23 2009 from onlusr.arl.wustl.edu
onl060> ping -c 3 n2pl
IS TT97 TBEZ732) 56(84] bytes of data.
send 3 pkts Ftes from nZpla (192.168.2.32): icmp_seq=1 Ltl=62 time=164 ms
54 bytes from nZpla [192.168.2.32): icmp seq=2 ttl=62Z time=0.077 ms
to n2p1 64 bytes from nZpla [1092.166.2.32): icmp seq=3 ttl=62 time=0.076 ms

--- nZpla ping statistics --- \
3 packets transmitted, 3 received, 0% packet loss, time 1990ms

rot mindavg/mad/mdev = 0.076/54.778/164.181/77.359 ]
onloso> -

22 - Ken Wong— 10/14/2009 & Washington University in St.Louis




Send UDP pkts from n1p0 to n2p1l

Il
PRSI o Loborotory nketace x

onlusr> ssh onlD6D A

Last login: Mon Oct 12 12:08:57 2008 frow onlusr.arl.wustl.edu

onlO60> /usr/local/bin/iperf -¢ n2pl -u -w 1w -b 20m -t 20 [ ]

nzn2p1

Client connecting to niZpl, UDP port 5001 ol ol e

Gending 1470 byte datagrans 192 162,332

UDP buffer size: 2.00 MByte (VARNING: reguested 1.00 MBvte) 4 2 4 2 Monitoring
AP 1 APR.2 User Data

3] local 192.168.1.16 port 32769 connected with 192.168.2.32 port 5001
3] 0.0-20.0 sec 47.7 MBytes 20.0 Mbits/sec
Sent 34015 datagrams

3] Server Report:

3] "0.0-20.0 sec 27.2 MBytes 11.4 Mbits/sec 0.221 ms 14594/34013

(43%)

w

3] 0.0-20.0 sec 1 datagrams regeived out-of-order

oy ] .4

on1o60> / =lolx
/ Options Parameter View
- .
server got 11.4 Mbps
0
E BE 14
@ 20
21
onl100.atl.wustledu - PuTTY @ o
onlusr> ssh onlO67
Last login: Fri Oct 9 15:25:02 2009 from onlusr.arl.wustl.edu
onl0O67> fusr/local/hin/iperf - - -w 1im x [ s
1 T T T

Server listening on UDP port 5001 TSE 13T 13096 1382
Receiving 1470 byte datagrams (3640, 114619 time{secs)
UDP buffer size: 2.00 MEyte (WARNING: requested 1.00 MByte) [ mo
[ 3] loecal 192.165.2.32 port 5001 %nnacted with 192.165.1.16 port [
[ 31 0.0-20.0 sec 27.2 MBytes 11.4 Mbits/sec 0.221 ms 14594/34013 (43%)
[ 31 0.0-20.0 zec 1 datagrams received out-of-order o

23 - Ken Wong— 10/14/2009

ifconfig and netstat commands

.wustl.edu - PuTTY ;Iglill
onlusr: ssh onl0s0 . )
Last login: Mon Oct 12 12:11:33 2008 from onlusr.srl.wuscl.edu ethO control interface
onl060> /shindifconfig ethi
ethi Link encap:Ethernst HWaddr 00:E0:51:5E:9C:iB7 L 10.0.0.90

inet sddr:10.0.0.60 Beosst:10.255.255.255 Mask:255.0.0.0 “

UP BROADCALST RUWNNIMG MULTICAST MTU:1500 Metric:1l

RE packets:3448 errors:0 dropped:0 overruns:0 frame:0
TZ packets:2844 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txogueuslen: 1000

RY byres:578003 (564.5 KiB) TX bytes:200494 (283.6 KiE)
Interrupt:20

. . | ethl data interface
onl0e0> /shin/ifconfig echl
ernl Link encap:Ethernet HWaddr 00:EQ:81:5E:90:Bs L192168116

inet addr:192.163.1.16 EBrast:1092.165.1.16 Mask:255.255.255.255
UP BROADCALST RUWNNIMG MULTICAST MTU:1500 Metric:1l

RE packets:g errors:0 dropped:0 overruns:0 frame:0

TZ packets:34024 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txogueuslen: 1000

RY bytes:1926 (1.8 KiB) TX bytes:51568882 (40.1 MiEB)
Interrupt:1é Base address:0x41000

onloso>

/bin/netstat

* onl100.aHl.wustledu - PuTTY =10/l
onl0&0> /hbin/necstan -i ;I
Fernel Interface tsble

Iface NTU HNet RZ-OK RE-ERR RX-DRF RE-OVER TZ-COK TZ-ERR TE-DRF TZ-OVRE Fly
ethl 1500 x) 3540 x) o x) 2504 x) a 0 BMRI
ethl 1500 x) 3 x) o x) 34024 x) a 0 BMRI
lo 16436 x) a0 x) o x) a0 x) a 0 LRU
onloco> [ :1
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Route Tables

all RTs start empty | [EBRermote boratoryinerices (U= TS

S— File Edit Monitoring Topology Extras
5 NPR.1:portd Route Table '
Edit
priority:|fi0 |
pr |nex1 hup| slats
Route Table [
nipd Filter Table nap2
Gueve Table
EANPR.1:porto o [=] eS|
B Remote Laboratory Interface (RL i [=] 3] Tables
n N P i = Errar Log
File Edit Tupuluwl Extras ] NPR.1:port0 Route Table

I

Add NSPCluster Blit—— | add/delete
Add NPRCluster pﬂnrily'.]auil .

Add Host  prefimask  [nedhop slals entries

Add GigE Switch 192.168.1.16/28

o
192.168.1.22128 1

Add Link 192.168.1.48/28 2
2

1

1

Add NetFPGA 13 192.168.1.6428
Generate Default Routes 192.168.1.80i28

192.168.2.00124 6
Adanew Hef aware Type

mm\’iplek{ {sncwsrror Log
] to NPR 2
affects every port, every NPR] output port
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Queue Tables and Port Rate

B remote Laboratory Interface o (=] S|

File Edit Monitoring Topology Extras

BAnPR.1:portl =13l=|
Tables
ﬁ NPR.1:port1 Queues
Edit
Port Rate(Mbps)j 11.611 |

queue id | threshold{Eyies) \uuamum
default |3z788 |256

| Route Table
Filter Table

Queus Tabls

ReadQLength

RXPKT

m Default port rate = 1 Gbps
m Requested 12 Mbps

»actual max port rate after commit = 11.611 Mbps
e 683 Kbps granularity

« 11.611 Mbps = 17 x 0.683 Mbps

26 - Ken Wong— 10/14/2009
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Bandwidth Monitoring (1)

Add Monitoring Display
Add Parameter Table
Show Monitors

=
lz‘ Name:
| |bancwicth | |
—
Bbandidet: o [=] eS|
Options| Psrameler‘ View
- Add Parameter
aTeter
5 4| Add Formula
=
]
@
or
= 0
T T T T T >
W36 W08 WA 3T A8 334d
time(secs)
[«i] [

Remote Laboratory Interface =10l x|

File Edit Monitoring Topology Extras

Route Table

Filter Table nzpi
Gueue Table

—Enter Polling Rate

rate:

Add Parameter
secs: 1

Enter

Xl

{
View \j
-
=
=
= REBYTELD
&
=
hd [ —
T T T T i
44 3144 344 3344 Jddd
time(secs)
[ 1 ] D]
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Bandwidth Monitoring (2)

B bandwidth —[O| x|
Options Parameter |View ‘
a a5 9. Show Values
Reset View
- il
§ 06 Change Y-axis label i
@ Set Log Scale :* g ?
)<
g 153 Zoom In From Selection 22
- o '
T T T T T 15
%93 77T 76 @43 @7 10
bandwidth: change y-axis label x|
T units{Mbis [~]
optional Iahel:| |

default label is unit type.

[change Y-axis Iabel]

select legend label to
modify chart properties

name:

10

NPR.1:port0

Port 0

read rx byte count/sec

® rate  absolute value

Polling every 1.0 seconds

Units: bytesis converted to: |ths ‘ - | scaled hy'.‘1 a

[ ] Dashed Line




Experiment 1 Shell Script

See ~kenw/bin/run-473

. - onl100.arLwust.edu - PuTTY =]
Puts $n1p0, etc into

onlusr> 1s -1 bin/run—473 =
: v —ruxr--r-- 1 kenw onluser 405 2009-10-11 2Z:16 bin/run-473

Unix environment onlusr> cat bin/run-473

#!/bin/=h

#

# Purpose: run cse473s experiment 1

source fusers/onl/.topology # get defs of external interfaces

[start 2 UDP receivers]\‘* seart o wip reseivers

for host in $n2pl $nzpZ; do
ssh $host /usr/local/bin/iperf -s -u -w Im &

done

sleep 1

# start 2 udp senders staggered by 6 sec
start 1st UDP sender ssh §nlp0 /usr/local/bin/iperf —c n2pl —u -w 1m -b 10m

sleep 6
[Walt 6 seconds ]/ssh $nlp4 /fusr/local/bin/iperf —c n2pZ -u -w 1m -b 10m -t 20 &

onluses [ / \—\ z
[ start 2nd UDP sender
[run as client; send to n2p2] M}
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Experiment 1 Shell Script

See ~kenw/bin/run-473

- onl100.arLwustl.edu - PuTTY =10 %]

Puts $n1p01 etc into - onl100.arl.wustl.edu - PUTTY =1o]x|
Un|X env”‘onment onluse> ls -1 bin/run-473 d

—rwxr--r-- 1 kenw onluser 405 2009-10-11 22:16 bin/run-473
onlusr> cat bin/run-473

#!/bin/sh

#

# Purpose: run csed473s experiment 1

#

. source fusers/onl/.topolo # get defs of external interfaces
[start 2 UDP recewers]\ reesy §

# start 2 udp receivers
for host in $nZpl $nZpZ; do
ssh jhost /usr/local/bin/iperf -s -u -w 1m &

done

il

sleep 1

[ start 1st UDP sender ]—# start 2 udp senders staggered by § sec

ssh $nilpd /usc/leocal/bin/iperf —¢ nZpl —uw —w im -b 10m -t 20 &

[wait 6 seconds ]/SIEEP i

ssh §nlp4 /usr/local/bin/iperf -c nZp2 -u -v 1w -b 10m -t 20 &
[start 2nd UDP sender onluse> [l =

[run as client; send to n2p2] 2 1 (Sl
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Experiment 1 (Final Version)

| B Remote Laboratary Interfa =10 NPR 2, port 1 receives
File Edit Monitoring Topology Extras Trafﬁc at ALMOST 12 Mbps
=10l x|
1.0
=14
B
‘ 23
! e T £
NPR'l NPR.2 552{ BF4.8 8873 6998
(337.648, 11,462 ) timeysecs)
Mb;lag 12 ébps T — [i]1»]
(S TSR LL]:L S =i
¥l
asbg 12—l "2 nip0 starts | | n1p4 starts
10
Mbps Gbps

& Washinzton University in St.Louis
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Experiment 2
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Using Reserved Queue 64

-0 x .
— =lojx]
Tahl
ables File Edit Monitoring Topology Extras
E NPR.1:port1 Queues
Edit | ‘
source addr |0.0.0.0/0 |suurce purl:|*
Add Queue s):|11 611 o S ,—
Delete Quene  tsholc(bytes) | quanturr destination address/mask: 0.0.0.0/0 | port; |
“ 256 | protocol:* . |
y [t :
=
Tables psvi
= tcprst
[5] NPR.1:port1 Queues a
tcppsh
Edit
Port Rate(Mbps){11.611 | fepack
ort Rate(Mbps); LLL™ [t0 Filter Table
gueus id thresholdiytes) | guantum) tcpurg
default 32TER 1600 N
51 600000 1500 au: [ mutticast: [_] addr
portiplugin seleminn:|mm only | - |"""": o
N pling Filter Types
| output ports:)| \nmnut plugins:
B 1 datagr 63) reserved 8191
|q|d:|54| | ez ) )
plugin tag(0-31 or *)[n |
add reserved queue priority(0-63): 5 isampling type (aux only):
64 (600,000 bytes) [ -]
EXRTC
Commit

it ’—npl Shaw Error Log
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Monitoring Queue Length

emote Laboratory Interfai
File Edit

=10l

Monitoring ‘ Topology Extras

Add Monitoring Display
,E\ Add Parameter Table
nte® Show Monitors nzpl

Set Default Polling Rate

AT,

—
nips

Name:

‘Gueue Length\ \

=[5
Options | Parameter | View
- 2 Add Parameter
RemoveParameter *
; 4| Add Formula
=
@
&
o
= o
T T T T T T
37934 38017 3P0 39164 38T 3835
time(secs)
Kimn| [»]
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File Edit Monitoring Topology Extras

T Route Table

.
LY
nipd Filter Table nipl

Qusus Tzble

ReadQLength
RXPKT

Add Parameter

x|
queue_id: |54

Enter Polling Rate

secs:|]

[ rate:

i




Experiment 2 Displays

=lolx
=10
14
™20
1521
22
— - £
30099 024 31149 3127,
(33340, 11.452 ) lihe(se:s)
B queue length 3 - o) x|
Options Parameter View |
o 500,200
g modeey
&
& qlen 1.1/54
199,732.3
= 0

20003 31028 31153 3127

time(secs)
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Delaying Packets

37 - Ken Wong— 10/14/2009

nington Univers

eAdd a delay plugin

eAdd a filter F

i

NPR.1

standard plugins
~onl/npr/plugins/
emuink
Router NPR.2 Plugins SRS,
Edit| nuliz
P Base Address: 102,163 2.0 -
CP hast: nprop 12 ar must] edu Send Command to Plugin null
—¢ Configuration Show Plugin Command Log | nstats
nipd UDP traffic Plugin Table | | AddPlugin Data to Graph ipHdr
sndr FluginDebugging L=4| Add Plugin Directory delay
Add Plugin H count

[5

possible plugin ME
numbered 0-4

)

Router NPR.2 P.... [|[B][X]

1_,"F- B X F--a 1 plugin Imicra e
©Q3009—> 1U
4—peR----- >3—;F""

microengine 0
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Add The Filter

Remote Laboratory Interf. ‘@

— Add Filter
File Edit Monitoring Topology Extras NPR.2: port1 T
source addr 0.0.0.0/0 source pnrl:l* |
Tables | PP L
addr 00.0 00 | port]* |
[7] NPR.2:port1 Fiter Table i """"C"':EB § P
Edit | ol
Addfier e | R ARP
Edit Fifter teprst |lJ -
Stop Stats tcppsh IP Opt 5
Delete Filter tcpack
1L
tcpurg 0
aux: [ multicast: [
. . drop:
port/plugin selectlun:|p|uuin only ‘ - |" v: 1
—

output ports:z | | [output plugi :3 | |

N PR. 2 N PR. 1 qid:@:datagram 63) reserved 8191)
plugintag(0-31 or *yjn |
priority(0-63):

E B PR, 2: port2
1_’"F. - r"‘L Tables
©Q300¢4 = [£] NPR.2:port2 Queues
4—pR----- ;3_;|:_—-V Edit
Port Rate(Mbps); 0.683 |

ueue id threshold{bytes) | guantum
At B a5t
00 100000 1500

10/14/2009

mit rmp\ Show E

m|
onlusr> ssh onl037 L
Last login: Wed Jan 26 10:22:24 2009 from onlusr.arl.wustl.edu
onl037> necstat -i
Fernel Interface table
Iface NTU Met RI-OK RX-ERR RX-DRF RE-CVER TZ-OK TX-ERE TX-DRF TZ-OVE Flg
erhi 1500 o 4z13 o o o 3552 o o 0 BMRIT
erhl 1500 o o o o o 3 o o 0 BMRIT
lo 16436 o a4 o o o a4 o o 0 LRU

onl037> ping -o 5 nlpl
PING nipla (192.168.1.32) 56(84) hytes of data.
64 hytes from nlpla (192.1656.1.32): icwp_seq=1 ttl=6j time=I57 ms

64 hytes from nlpla (192.1656.1.32): icwp_seq=Z ttl=6j time=50.1 ms
64 hytes from nlpla (192.1656.1.32): icwp_seq=3 ttl=6j time=50.1 ms
64 hytes from nlpla (192.1656.1.32): icwp_seq=% ttl=6j time=50.1 ms
64 hytes from nlpla (192.1656.1.32): icwp_seq=5 ttl=6j time=50.1 ms

—--— nlpla ping statistics -—--

5 packets transmitted, 5 received, 0% packet loss, time 4000ms
ret mindavg/wax/wdev = 50.101/91.6368/257.772/63.067 ns
on1o37> ]

<
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Send Control Message to Plugin

ESl Router NPR.Z P..
NPR.2 Send Command CommandPlugin

Edit
Send Command to Plugin ‘ E‘ microengine: 0
Show Plugin Command Log [aetay=100 |

Add Plugin Data to Graph
Add Plugin Directory -
Delete Plugin

Add Plugin »

other messages:

e=delay return delay (msec)
e=counts return npkts, maxing, ndrops
ereset reset global counters

delay= 100 - succeeded. Returned 100

onl037> ping -c 5 nipl -

PING nipla (192.168.1.32) S56(54) bytes of data.
64 bytes from nlpla [192.168.1.32): icmp seq=1 ttl=62| time=100 ms
64 bytes from nlpla [192.168.1.32): icmp seq=2 ttl=62| time=100 ms
64 bytes from nlpla [192.168.1.32): icmp seq=3 ttl=62| time=100 ms
64 bytes from nlpla [192.168.1.32): icmp seq=4 ttl=62| time=100 ms
64 bytes from nlpla [192.168.1.32): icmp seq=5 ttl=62| time=100 ms

1
1
1
1

-—— nipla ping statistics --—-—

5 packets transmitted, 5 received, 0% packet loss, time 3999ms
rtt min/avg/max/mdev = 100.100/100.105/100.118/0.283 ms
onlo37s

<
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